Evaluation Board for the AD4000 Series 16-/18-/20-Bit Precision SAR ADCs

FEATURES
- Fully featured evaluation board for 10-lead precision ADCs
- Versatile analog signal conditioning circuitry
- On-board reference, reference buffers, and ADC drivers
- PC software for control and data analysis of time and frequency domain
- System demonstration platform-compatible (EVAL-SDP-CH1Z)

EVALUATION BOARD KIT CONTENTS
- AD4000/AD4001/AD4002/AD4003/AD4020 evaluation board
  (see Table 6)
- 12 V wall adapter power supply

EQUIPMENT NEEDED
- SDP-H1 board (EVAL-SDP-CH1Z)
- Precision signal source
- Cable (SMA input to evaluation board)
- Standard USB A to mini-B USB cable
- Band-pass filter suitable for 16-bit, 18-bit, and 20-bit testing
  (value based on signal frequency)
- AD40xx evaluation software

GENERAL DESCRIPTION
The AD4000/AD4001/AD4002/AD4003/AD4020 family evaluation board covers the ease of use, 16-/18-/20-bit, precision successive approximation register (SAR) analog-to-digital converters (ADCs). The AD4000/AD4001/AD4002/AD4003/AD4020 are low power, 16-bit/18-bit/20-bit, precision SAR ADCs that offer very high performance with throughputs up to 2 MSPS (1.8 MSPS for the AD4020). The evaluation board is designed to demonstrate the performance of the AD4000/AD4001/AD4002/AD4003/AD4020 family of ADCs and to provide an easy to understand interface for a variety of system applications. A full description of these products is available in their respective data sheets, which must be consulted when using this evaluation board.

The EVAL-AD4000FMCZ/EVAL-AD4001FMCZ/EVAL-AD4002FMCZ/EVAL-AD4003FMCZ/EVAL-AD4020FMCZ evaluation boards (see Figure 1) are ideal for use with the Analog Devices, Inc., high speed system demonstration platform (EVAL-SDP-CH1Z). These evaluation boards interface to the SDP-H1 board via a 120-pin connector. SMA connectors, JP2 and JP3, are provided for the low noise analog signal source.

On-board components include a high precision buffered band gap 5.0 V reference (the ADR4550), a reference buffer (the ADA4807-1), a common-mode buffer (the ADA4807-1), a signal conditioning circuit with two op amps (the ADA4807-1), and a power supply to derive the necessary voltage levels to supply all voltage needs.

The EVAL-AD4000FMCZ, EVAL-AD4001FMCZ, EVAL-AD4002FMCZ, and EVAL-AD4003FMCZ are populated with the AD4000, AD4001, AD4002, and AD4003, respectively. However, these boards can be used to evaluate the performance of the AD4004, AD4005, AD4006, AD4007, AD4008, AD4010, and AD4011 by limiting the sample rate in the evaluation software to the maximum sample rate of the specific ADC. For example, the AD4000 on the EVAL-AD4000FMCZ can be used to evaluate the performance of the AD4004 if the sample rate is limited to 1 MSPS. See the data sheet of each product for its corresponding evaluation board.
TABLE OF CONTENTS

Features ................................................................................................ 1
Evaluation Board Kit Contents .......................................................... 1
Equipment Needed ........................................................................ 1
General Description ......................................................................... 1
Revision History ........................................................................... 2
Evaluation Board Photograph ......................................................... 3
Evaluation Board Hardware ............................................................ 4
Setting Up the Evaluation Board ...................................................... 4
Power Supplies ............................................................................ 4
Reference, Reference Buffer, and Common-Mode Buffer ......... 4
SDP-H1 Controller Board ........................................................... 5
Solder Links ................................................................................... 5
Analog Inputs ................................................................................ 5
Evaluation Board Software ............................................................. 6
Installing the Software ................................................................ 6
Installation Steps .......................................................................... 6
Board Operation/Connection Sequence ................................... 8
Running the Software with the Hardware Connected ............. 8
Software Operation ........................................................................ 9
Description of the User Panel ...................................................... 9
Waveform Capture ....................................................................... 11
AC Testing—Histogram .............................................................. 12
DC Testing—Histogram .............................................................. 12
AC Testing—FFT Capture ............................................................ 13
Summary Tab .............................................................................. 14
Troubleshooting .......................................................................... 15
Software .................................................................................... 15
Hardware .................................................................................... 15
Evaluation Board Schematics and Artwork ................................. 16
Products on This Evaluation Board ............................................. 23
AD4000/AD4001/AD4002/AD4003/AD4020 Evaluation
Board Bill of Materials ............................................................... 23
Related Links .............................................................................. 25

REVISON HISTORY

1/2018—Rev. D to Rev. E
Added AD4002, AD4006, AD4010 .............................................. Throughout
Changes to Figure 2 and Setting Up the Evaluation Board Section ......................................................... 4
Changes to Table 6 ........................................................................ 26

9/2017—Rev. C to Rev. D
Change to General Description Section ................................. 1

7/2017—Rev. B to Rev. C
Added AD4020 ........................................................................ Universal
Added EVAL-AD4020FMCZ ................................................ Universal
Changes to User Guide Title and Subject, Evaluation Board Kit Contents Section, and General Description Section .......................... 1
Moved Evaluation Board Photograph Section ...................... 3
Changes to Figure 2 and Setting Up the Evaluation Board Section ......................................................... 4
Changes to Table 3 ........................................................................ 5
Changes to Figure 18 ................................................................. 9
Changes to Description of the User Panel Section .......... 10
Changes to Table 6 ........................................................................ 25

1/2017—Rev. A to Rev. B
Added AD4001 ........................................................................ Universal
Changes to User Guide Title .................................................... Throughout
Changes to User Guide Subject Line ........................................ 1
Changes to Figure 2 ...................................................................... 3
Changes to Table 3 ..................................................................... 4
Moved Troubleshooting Section ............................................. 4
Changes to Table 5 .................................................................... 15
Changes to Table 6 ................................................................. 22

10/2016—Revision 0: Initial Version

11/2016—Rev. 0 to Rev. A
Added Figure 1, Renumbered Sequentially .............................. 1
Changes to General Description Section .............................. 1
Changes to Setting Up the Evaluation Board ......................... 3

10/2016—Revision 0: Initial Version
EVALUATION BOARD PHOTOGRAPH

Figure 1.
EVALUATION BOARD HARDWARE

SETTING UP THE EVALUATION BOARD

Figure 2 shows the simplified evaluation board block diagram. Figure 25 shows the evaluation board schematic. The board consists of the ADC, U1, with a reference, U6 (ADR4550), and ADC drivers, U12 and U14, the ADA4807-1 for the AD4001/AD4002/AD4003/AD4020 and the ADA4805-1 for the AD4000 (see Table 5). The user also has an option to populate U2 with a low power, fully differential ADC driver such as the ADA4940-1 when evaluating the AD4001/AD4003/AD4020. The evaluation board is a flexible design that enables the user to select components in addition to operating from an adjustable bench top power supply.

POWER SUPPLIES

The system demonstration platform (SDP-H1) board supplies 12 V to power the necessary rails for the AD4000/AD4001/AD4002/AD4003/AD4020 evaluation board.

Table 1. Power Supplies Provided on the Board

<table>
<thead>
<tr>
<th>Power Supply (V)</th>
<th>Function</th>
<th>Components Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>5, 7 (default)</td>
<td>Positive rail</td>
<td>ADP7118</td>
</tr>
<tr>
<td>−2.5 (default)</td>
<td>Negative rail</td>
<td>ADP2370, ADM660, ADP7182</td>
</tr>
<tr>
<td>1.8</td>
<td>ADC power</td>
<td>ADP7118, ADP5300</td>
</tr>
<tr>
<td>3.3</td>
<td>VREF (digital power)</td>
<td>ADP7118</td>
</tr>
</tbody>
</table>

1 See Table 2.

The 7 V amplifier positive rail (+Vs) is generated from U17 (the ADP7118). The −2.5 V negative amplifier rail (−Vs) is generated by a combination of U3 (the ADP2370), U7 (the ADM660), and U21 (the ADP7182).

Each supply is decoupled where it enters the board and again at each device. A single ground plane is used on this board to minimize the effect of high frequency noise interference.

In addition, there is also the ability to power the board from a bench top power supply. The screw terminals, J2 and J3, are provided for this function. When bench power is used, the onboard power supplies are no longer required. The solder links also must be changed: SL1 = SL2 = SL5 = SL6 = SL7 = SL8 = SL9 = B.

REFERENCE, REFERENCE BUFFER, AND COMMON-MODE BUFFER

An external 5 V reference (U6, ADR4550) is used by default to supply the ADCs directly. However, the user can also use one of the 2.5 V, 3.3 V, and 4.096 V references by changing the reference device on the board (U6, ADR4525/ADR4533/ADR4540). There is also an option to use a lower power reference (U22, ADR3450). Note that the ADR3450 cannot accept input voltages beyond 5.5 V. The ADA4807-1 is used as a reference buffer (U16) and common-mode buffer (U18) by default. However, it can also be replaced by the AD8031 if needed without compromising the performance.
SDP-H1 CONTROLLER BOARD

The evaluation board uses a serial port interface (SPI) and is connected to the high speed controller board for the system demonstration platform (SDP-H1) controller board. The SDP-H1 board requires power from a 12 V wall adapter. The SDP-H1 has a Xilinx® Spartan 6 and an ADSP-BF527 processor with connectivity to the PC through a USB 2.0 high speed port. The controller boards allow the configuration and capture of data on daughter boards from the PC via USB.

The SDP-H1 has an FMC low pin count (LPC) connector with full differential low voltage differential signaling (LVDS) and singled-ended low voltage complementary metal-oxide semiconductor (LVCMOS) support. It also has the 120-pin connector, found on the SDP-B, which exposes the Blackfin® processor peripherals. This connector provides a configurable serial, parallel I2C and SPI, and general purpose input/output (GPIO) communications lines to the attached daughter board.

SOLDER LINKS

The three solder link options on the evaluation board are configured depending on which generic of the ADC is on the specific evaluation board, as described in Table 3.

Table 2. Jumper Detail with Factory Default Setting

<table>
<thead>
<tr>
<th>Link</th>
<th>Default</th>
<th>Function</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>SL1</td>
<td>A</td>
<td>+Vss</td>
<td>Change to B if using bench supplies</td>
</tr>
<tr>
<td>SL2</td>
<td>A</td>
<td>−Vss</td>
<td>Change to B if using bench supplies</td>
</tr>
<tr>
<td>SL5</td>
<td>A</td>
<td>+Vss</td>
<td>Change to B if using bench supplies</td>
</tr>
<tr>
<td>SL6</td>
<td>A</td>
<td>−Vss</td>
<td>Change to B if using bench supplies</td>
</tr>
<tr>
<td>SL7</td>
<td>A</td>
<td>VDD for ADC</td>
<td>Change to B if using bench supplies</td>
</tr>
<tr>
<td>SL8</td>
<td>A</td>
<td>−Vss</td>
<td>Change to B if using bench supplies</td>
</tr>
<tr>
<td>SL9</td>
<td>A</td>
<td>+Vss</td>
<td>Change to B if using bench supplies</td>
</tr>
<tr>
<td>LK2</td>
<td>A</td>
<td>VREF</td>
<td>Change to B if using the ADR3450</td>
</tr>
<tr>
<td>LK5</td>
<td>B</td>
<td>SDI</td>
<td>Change to A if using V_DRIVE</td>
</tr>
<tr>
<td>JP1</td>
<td>B</td>
<td>FSEL (U3)</td>
<td>Change to A if using ground</td>
</tr>
<tr>
<td>JP2</td>
<td>B</td>
<td>ADC drivers</td>
<td>Change to A if using FDA ADA4940-1</td>
</tr>
<tr>
<td>JP3</td>
<td>B</td>
<td>ADC drivers</td>
<td>Change to A if using FDA ADA4940-1</td>
</tr>
<tr>
<td>JP4</td>
<td>B</td>
<td>ADC drivers</td>
<td>Change to A if using FDA ADA4940-1</td>
</tr>
<tr>
<td>JP5</td>
<td>B</td>
<td>ADC drivers</td>
<td>Change to A if using FDA ADA4940-1</td>
</tr>
<tr>
<td>JP7</td>
<td>B</td>
<td>V_DRIVE</td>
<td>Change to A if using external 3.3 V for V_DRIVE</td>
</tr>
<tr>
<td>JP8</td>
<td>B</td>
<td>STOP (U20)</td>
<td>Change to A if using CNV_FMC from SDP-H1 connector</td>
</tr>
</tbody>
</table>

Table 3. Jumpers Specific to 10-Lead Precision ADCs

<table>
<thead>
<tr>
<th>Link</th>
<th>Default</th>
<th>Configuration</th>
<th>Generic</th>
</tr>
</thead>
<tbody>
<tr>
<td>SL4</td>
<td>A</td>
<td>Differential input</td>
<td>AD4001, AD4003, AD4020</td>
</tr>
<tr>
<td>SL4</td>
<td>B</td>
<td>Single-ended or pseudo differential</td>
<td>AD4000, AD4002</td>
</tr>
</tbody>
</table>

ANALOG INPUTS

The analog inputs to the evaluation board are SMA connectors, J6 and J10. These inputs are buffered with dedicated amplifier circuitry (U12 and U14), as shown in Figure 27. The circuit allows different configurations, input range scaling, filtering, addition of a dc component, and use of different op amp and supplies. The analog input amplifiers are set as unity-gain buffers at the factory.

The default configuration sets both U12 and U14 at midscale, generated from a buffered reference voltage divider (VCM).

The evaluation board is factory configured to provide either a single-ended path or a fully differential path.

For dynamic performance, a fast Fourier transform (FFT) test can be performed by applying a very low distortion ac source.

For low frequency testing, the audio precision source (such as the SYS-2700 series) can be used directly because the outputs on these are isolated. Set the outputs for balanced and floating ground. Different precision sources can be used with additional filtering.

Because the evaluation board uses the amplifiers in unity-gain, the noninverting input has a common-mode input with a 590 Ω resistor divider, and it must be taken into account when directly connecting a source.
EVALUATION BOARD SOFTWARE
INSTALLING THE SOFTWARE

The evaluation board software can be downloaded from the EVAL-AD40XX-FMCZ product page.

Install the software before connecting the SDP-H1 board to the USB port of the PC to ensure that the SDP-H1 board is recognized when it connects to the PC.

1. Start the Windows® operating system and download the software from the relevant product page on the Analog Devices website.
2. Unzip the downloaded file. Run the setup.exe file.
3. After installation is completed, power up the evaluation board as described in the Power Supplies section.
4. Plug the evaluation board into the SDP-H1 board and the SDP-H1 board into the PC using a USB cable.
5. When the software detects the evaluation board, proceed through any dialog boxes that appear to finalize the installation.

The default location for the software is the following:
C:\Program Files\Analog Devices\AD40XX Evaluation Software\EVAL-AD40XX.

This location contains the executable software and example files.

INSTALLATION STEPS

Proceed through the installation, allowing the software and drivers to be placed in the appropriate locations. Connect the SDP-H1 board to the PC only after the software and drivers are installed.

There are two parts to the software installation. First, install the software related to the evaluation board, as follows:

1. Launch the evaluation board software installation by clicking the setup.exe file. The software installation window opens, as shown in Figure 3.

   ![Figure 3. AD40XX Evaluation Software Install Window](image)

2. Choose the folder location for installation and click Next. The default folder is shown in Figure 4.

   ![Figure 4. Destination Directory Window](image)

3. Accept the National Instruments software license agreement and click Next (see Figure 5).

   ![Figure 5. License Agreement Window](image)

4. Click Next again to install the software.

   ![Figure 6. Start Installation Window](image)
5. A pop-up window opens and displays a bar showing the installation progress, as shown in Figure 7.

![Figure 7. Overall Progress](image)

6. Click Next to complete the installation and to launch the SDP-H1 driver installation as shown in Figure 9.

![Figure 8. Installation Complete Window](image)

The second part of the software installation is the drivers related to the SDP-H1 board. These drivers must be installed for the evaluation board to function correctly.

![Figure 9. Beginning of SDP-H1 Driver Installation](image)

1. The ADI SDP Drivers 2.2.95.68 Setup Wizard opens. Click Next to install the SDP-H1 drivers.

![Figure 10. ADI SDP Drivers 2.2.95.68 Setup Wizard Window](image)

2. Choose the installation location and click Install; the default folder is shown in Figure 11.

![Figure 11. Choose Install Location Window](image)

3. The installation begins, and a progress bar is displayed.

![Figure 12. Installing Window](image)
4. Click Close to complete the installation.

**RUNNING THE SOFTWARE WITH THE HARDWARE CONNECTED**

To run the program, take the following steps:

1. Click Start > All Programs > Analog Devices > AD40XX Evaluation Software > EVAL-AD40XX. To uninstall the program, click Start > Control Panel > Programs and Features > Analog Devices AD40XX Evaluation Software.

2. The software automatically seeks to find the hardware connected; therefore, when no hardware is connected, it displays a connectivity error (see Figure 15) when the software is launched. Connect the evaluation board to the SDP-H1 and connect the SDP-H1 to the USB port of the PC, wait a few seconds, click Rescan, and then follow the instructions (see Figure 15).

3. If Cancel is clicked, a message appears as shown in Figure 16.

4. The software then connects to the board and displays the message shown in Figure 17.

5. When the board is correctly detected, the software panel opens.
SOFTWARE OPERATION

When the software launches, the panel opens and the software searches for the hardware connected to the PC. The software detects the generic attached to the PC, and the software panel then launches as shown in Figure 18.

DESCRIPTION OF THE USER PANEL

The following is the description of the user panel.

The File menu (Label 1 in Figure 18) has the choice of the following options:

- **Save Captured Data** allows the user to save the current captured data for later analysis; the file format is .csv. The user is prompted to choose or enter the path of the file in the Save As dialog box (see Figure 19). Save to an appropriate folder location.
- **Load Captured Data** opens the Load File dialog box, where the user is prompted to load previously captured data in .csv format for analysis.
- **Take Screenshot** allows the user to save the current screen capture as a .jpg.
- **Print Screenshot** allows the user to save the current screen capture as a .pdf.
- **Exit** stops running the application software.
The **Edit** menu (Label 1 in Figure 18) provides the option to reset the software to its initial state (**Reinitialize to Default Values**).

The **Help** menu (Label 1 in Figure 18) offers information about the following:
- Analog Devices Website
- User Guide
- Context Help
- About

When hardware is connected to the USB port, the software automatically detects which generic is connected and displays it (Label 2 in Figure 18).

The **Throughput** box is Label 3 in Figure 18. The default value is the maximum sample rate that the active device can support without turbo mode enabled. The maximum supported throughput of 2 MSPS (or 1.8 MSPS for the AD4020) can only be achieved by enabling turbo mode (Label 11 in Figure 18). If the user enters a value larger than the ability of the existing device, the software reverts to the maximum throughput. The user can adjust the throughput to a minimum of 10 kSPS.

The **Voltage Reference** dropdown menu is Label 4 in Figure 18. By default, this reference is 5 V (ADR4550 on-board reference). The minimum/maximum voltage calculations are based on this reference voltage. If the user changes the reference voltage, this input must be changed accordingly.

Click **Single Capture** to perform a single capture and click **Continuous Capture** to perform a continuous stream capture from the ADC. (Both are noted with Label 5 in Figure 18.)

Select **Samples** (Label 6 in Figure 18) to analyze data using the particular number of samples. The maximum number of samples the software can support is 524,288.

Four capture tabs (Label 7 in Figure 18) display the data in different formats, as follows:
- Waveform
- Histogram
- FFT

### Summary

Click **Enable Status Bits** (Label 8 in Figure 18) to enable the content of status header. Status bits can be clocked out at the end of the conversion data using six extra clocks when it is enabled.

Click **Span Compression** (Label 9 in Figure 18) to enable the ADC span compression feature. In single-supply applications, the use of span compression increases the headroom and footroom available to the ADC driver by reducing the input range by 10% from the top and bottom of the range while still accessing all available ADC codes.

Click **High-Z Mode** (Label 10 in Figure 18) to enable the internal high-Z mode. Enabling this mode allows the low input current for the ADC and improves total harmonic distortion (THD) performance using low power/bandwidth precision ADC drivers for slow/dc type signals.

Click **Turbo Mode** (Label 11 in Figure 18) to enable turbo mode and run the ADC at the full throughput of 2 MSPS.

Click **Read Register** (Label 12 in Figure 18) to check if any of the ease of use features are enabled, including span compression, high-Z mode, turbo mode, an overvoltage condition (which is a sticky bit), and the status bits.

Clicking **Enable Status Bits** enables the six status bits, and the content of the six bits is updated and displayed in the **Status Header** section (Label 13 in Figure 18) after clicking single or continuous capture. Note that the overvoltage clamp flag status bit updates on a per conversion basis.

When the **Busy** indicator (Label 14 in Figure 18) is lit, the user must wait until the software completes the data analysis.

This software allows the user to select the **Oversampling Ratio** (Label 15 in Figure 18) up to 256 from the dropdown menu located in the **Configure** tab. The oversampling capability is implemented in the evaluation software by averaging the ADC output samples, that is, by summing the number of ADC samples and dividing it by the oversampling ratio to obtain the increased dynamic range.

To exit the software, click **File > Exit**.

Within any of the chart panels, the tools shown in Table 4 allow user control of the different chart displays.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Cursor" /></td>
<td>This tool controls the cursor, if present.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom" /></td>
<td>This tool zooms in and out.</td>
</tr>
<tr>
<td><img src="image" alt="Pan" /></td>
<td>This tool is used for panning.</td>
</tr>
</tbody>
</table>

The evaluation software allows the user to export the raw data or image. Right clicking any of the four capture tabs (Waveform, Histogram, FFT, and **Summary**) open the menu as shown in Figure 20, and the user can either export the raw data in Excel format or save an image in .bmp, .eps, or .emf format.
WAVEFORM CAPTURE

Figure 21 illustrates the waveform capture. The input signal is a 1 kHz sine wave. The waveform analysis reports the amplitudes recorded from the captured signal in addition to the frequency of the signal tone.
AC TESTING—HISTOGRAM

The ac testing histogram tests the ADC for the code distribution for the ac input, computes the mean and minimum/maximum amplitude and LSB size of the converter. Raw data is captured and passed to the PC for statistical computations. To perform a histogram test, click the Histogram tab and click Single Capture or Continuous Capture. Note that an ac histogram needs a quality signal source applied to the J6 and J10 input connectors. Figure 22 shows the histogram for a 1 kHz sine wave applied to the ADC input and illustrates the different measured values for the data captured.

DC TESTING—HISTOGRAM

More commonly, the histogram is used for dc testing where the user tests the ADC for the code distribution for dc input, computes the mean and standard deviation, or transition noise, of the converter, and displays the results. Raw data is captured and passed to the PC for statistical computations. To perform a histogram test, click the Histogram tab and click Continuous Capture. Note that a histogram test can be performed without an external source using a V_{REF}/2 (590 Ω resistor divider) at the ADC input. To test other dc values, apply a source to the J6 and J10 input connectors. It may be required to filter the signal to make the dc source noise compatible with that of the ADC.

Figure 22. Histogram Tab, Histogram Captured for Sine Wave
AC TESTING—FFT CAPTURE

The traditional ac characteristics of the converter can be displayed on the FFT tab. As in the histogram test, raw data is captured and passed to the PC where the FFT is performed, displaying signal-to-noise ratio (SNR), signal-to-noise-and-distortion ratio (SINAD), total harmonic distortion (THD), and spurious-free dynamic range (SFDR). The data can also be displayed in the time domain. To perform an ac test, apply a sinusoidal signal to the evaluation board at the SMA inputs, J6 and J10. A low distortion, better than 100 dB signal is required to allow true evaluation of the device. One possibility is to filter the input signal from the ac source. A band-pass filter can be used, and its center frequency must match the test frequency of interest.

Furthermore, if using a low frequency band-pass filter when the full-scale input range is more than a few volts peak-to-peak, use the on-board amplifiers to amplify the signal, thus preventing the filter from distorting the input signal.

Figure 23 displays the histogram of the captured data that includes the following:

- The spectrum information.
- The fundamental frequency and amplitude in addition to the second to fifth harmonics.
- The performance data (SNR, dynamic range, THD, SINAD, and noise performance).

![Figure 23. FFT Tab (AD4003 Running in Turbo Mode)](image-url)
SUMMARY TAB

The Summary tab captures all the display information and provides them in one panel with a synopsis of the information, including key performance parameters, such as SNR and THD.

Figure 24. Summary Tab, Shows All Captured Windows
TROUBLESHOOTING

SOFTWARE

To troubleshoot the software, take the following steps:

1. Always install the software before connecting the hardware to the PC.
2. Always allow the install to fully complete (the software is a two-part installation, the ADC evaluation software and the SDP-H1 drivers). A restart is recommended after installation is finished.
3. When the user first plugs in the SDP-H1 board via the USB cable provided, allow the Found New Hardware Wizard to run, which may take a little time. However, allow this to happen before starting the software.
4. If the board does not appear to be functioning, ensure that the ADC evaluation board is connected to the SDP-H1 board and that the board is being recognized in the Device Manager, as shown in Figure 14.
5. If connected to a slower USB port where the SDP-H1 cannot read as quickly as it needs to, a timeout error may result. In this case, it is advised not to read continuously, or alternatively, to lower the number of samples taken.

HARDWARE

To troubleshoot the hardware, take the following steps:

1. If the software does not read back any data, do the following:
   a. Check that the power is applied within the power ranges described in the Power Supplies section.
   b. Using a voltmeter, measure the voltage present at each of the test points: +Vss, −Vss, 1P8V_VDD, VDD_1P8V, +3P3V, +5V, and REF1 and common-mode voltages (REF/2) at IN+ and IN− to ensure that they are correct. The SDP-H1 board LED1 must be lit.
   c. Launch the software and read the data. If nothing happens, exit the software.
   d. Power down the board and relaunch the software.
   e. If no data is read back, confirm that the ADC evaluation board is connected to the SDP-H1 board and that the board is being recognized in the Device Manager, as shown in Figure 14.
2. When the user is working with the software in standalone/offline mode (no hardware connected) and later chooses to connect hardware, close and relaunch the software.
EVALUATION BOARD SCHEMATICS AND ARTWORK

Figure 25. ADC Evaluation Board, Power Supplies

Power supply for Amplifiers

+12V Supply from SDP-HI

VBI = +5V, VOUT = +1.8V

VIN = +9V, VOUT = -2.5V

VIN = +9V, VOUT = +7V/5V/3.3V

Secondary Power Connectors
Figure 26. ADC Evaluation Board, Voltage Reference, Common-Mode and Reference Buffers

The Voltage reference can be configured for either +5V or ±2.5V. The ADR3450 (U22) can NOT accept input voltage more than 5.5V.

AD8031 can be used instead of ADA4807-1.
Figure 27. ADC Evaluation Board, ADC Drivers, and ADC
Figure 28. ADC Evaluation Board, SDP-H1 Connector and Glue Logic
Figure 33. ADC Evaluation Board, Layer 4
## PRODUCTS ON THIS EVALUATION BOARD

**AD4000/AD4001/AD4002/AD4003/AD4020 EVALUATION BOARD BILL OF MATERIALS**

<table>
<thead>
<tr>
<th>Name</th>
<th>Part Description</th>
<th>Manufacturer</th>
<th>Part Number</th>
<th>Stock Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>U1</td>
<td>16-/18-bit, 2 MSPS or 20-bit, 1.8 MSPS precision SAR ADC in 10-lead MSOP</td>
<td>Analog Devices</td>
<td>See Table 6</td>
<td>See Table 6</td>
</tr>
<tr>
<td>U2</td>
<td>Ultralow power, low distortion ADC driver, 4 nV/√Hz</td>
<td>Analog Devices</td>
<td>ADA4940-1</td>
<td></td>
</tr>
<tr>
<td>U3</td>
<td>High voltage, 1.2 MHz/600 kHz, 800 mA, low quiescent current buck regulator</td>
<td>Analog Devices</td>
<td>ADP2370</td>
<td>ADP2370ACPZ-5.0-R7</td>
</tr>
<tr>
<td>U4</td>
<td>Linear regulator, 3.3 V, ultralow noise, complementary metal–oxide semiconductor (CMOS)</td>
<td>Analog Devices</td>
<td>ADP7118</td>
<td>ADP7118AUJZ-3.3-R7</td>
</tr>
<tr>
<td>U6</td>
<td>Ultralow noise, high accuracy voltage reference</td>
<td>Analog Devices</td>
<td>ADR4550</td>
<td>ADR4550BRZ</td>
</tr>
<tr>
<td>U7</td>
<td>CMOS, switched capacitor voltage converter</td>
<td>Analog Devices</td>
<td>ADM660</td>
<td>ADM660ARZ</td>
</tr>
<tr>
<td>U8</td>
<td>IC EEPROM, 2 kb, 400 kHz, 8-lead SOIC</td>
<td>ST</td>
<td>M24C02-WMN6TP</td>
<td>Digi-Key 497-8552-1-ND</td>
</tr>
<tr>
<td>U12, U14 (only for AD4001/AD4002/AD4003/AD4020)</td>
<td>Low noise, high speed amplifiers</td>
<td>Analog Devices</td>
<td>ADAPA807-1</td>
<td>ADAPA807-1ARJZ</td>
</tr>
<tr>
<td>U12, U14 (only for AD4000)</td>
<td>Low noise, high speed amplifiers</td>
<td>Analog Devices</td>
<td>ADAPA805-1</td>
<td>ADAPA805-1ARJZ</td>
</tr>
<tr>
<td>U16, U18</td>
<td>Low noise, high speed amplifiers</td>
<td>Analog Devices</td>
<td>ADAPA807-1</td>
<td>ADAPA807-1ARJZ</td>
</tr>
<tr>
<td>U17</td>
<td>Linear regulator, 3.3 V, ultralow noise, CMOS</td>
<td>Analog Devices</td>
<td>ADAPA718</td>
<td>ADAPA718AUJZ-3.3-R7</td>
</tr>
<tr>
<td>U19</td>
<td>Linear regulator, 1.8 V, ultralow noise, CMOS</td>
<td>Analog Devices</td>
<td>ADAPA7118</td>
<td>ADAPA7118AUJZ-1.8-R7</td>
</tr>
<tr>
<td>U20</td>
<td>Ultralow power step-down regulator</td>
<td>Analog Devices</td>
<td>ADAPA5300</td>
<td>ADAPA5300ACPZ-1-R7</td>
</tr>
<tr>
<td>U21</td>
<td>Ultralow power step-down regulator</td>
<td>Analog Devices</td>
<td>ADAPA7182</td>
<td>ADAPA7182AUJ-2.5-R7</td>
</tr>
<tr>
<td>U22</td>
<td>Micropower, high accuracy, 5 V voltage reference</td>
<td>Analog Devices</td>
<td>ADAPA3450</td>
<td>ADAPA3450ARJZ-R2</td>
</tr>
<tr>
<td>C1, C2, C5, C9, C61</td>
<td>10 µF, 20 V tantalum capacitors</td>
<td>AVX</td>
<td>TAJB106K020RNJ</td>
<td>FEC 197427</td>
</tr>
<tr>
<td>C3, C4, C16, C17, C21, C26</td>
<td>10 µF, 20 V tantalum capacitors</td>
<td>Murata</td>
<td>GRM21BR71C225KA12L</td>
<td>FEC 1828829</td>
</tr>
<tr>
<td>C6</td>
<td>1 µF, X7R, 25 V, 0805 capacitors</td>
<td>Murata</td>
<td>LLL216R71E104MA01L</td>
<td>FEC 1735541</td>
</tr>
<tr>
<td>C7, C10, C12, C18, C40, C68, C73, C74, C75, C66, C77</td>
<td>0.1 µF, X7R, 25 V, 0805 ceramic capacitors</td>
<td>Murata</td>
<td>GRM188R71H104KA93D</td>
<td>FEC 8820023</td>
</tr>
<tr>
<td>C8, C57, C64, C69, C71</td>
<td>0.1 µF, X7R, 25 V, 0805 ceramic capacitors</td>
<td>Murata</td>
<td>LLL216R71E104MA01L</td>
<td>FEC 1294646</td>
</tr>
<tr>
<td>C14, C15</td>
<td>1 µF, X7R, 25 V, 0805 capacitors</td>
<td>Murata</td>
<td>GRM21BR71H105KA12L</td>
<td>FEC 1735541</td>
</tr>
<tr>
<td>C24, C30, C37, C41, C42, C44, C45, C48, C54, C60, C66, C67, C70</td>
<td>0.1 µF, X7R, 25 V, 0805 ceramic capacitors</td>
<td>Murata</td>
<td>LLL216R71E104MA01L</td>
<td>FEC 1294646</td>
</tr>
<tr>
<td>C35, C52</td>
<td>0.1 µF, X7R, 25 V, 0805 ceramic capacitors</td>
<td>Murata</td>
<td>LLL216R71E104MA01L</td>
<td>FEC 1294646</td>
</tr>
<tr>
<td>C11, C13, C19, C20, C25, C29, C32, C36, C38, C39, C43, C46, C47, C49, C50, C51, C55, C63, C72</td>
<td>180 pF, 50 V, 0603, COG/NP0 capacitors</td>
<td>YAGEO (Phycomp)</td>
<td>CC0603JRNP09BN181</td>
<td>FEC 3019494</td>
</tr>
<tr>
<td></td>
<td>SMD capacitors</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>Do not place</td>
</tr>
<tr>
<td>Name</td>
<td>Part Description</td>
<td>Manufacturer</td>
<td>Part Number</td>
<td>Stock Code</td>
</tr>
<tr>
<td>------</td>
<td>------------------</td>
<td>--------------</td>
<td>-------------</td>
<td>------------</td>
</tr>
<tr>
<td>C56</td>
<td>10 µF, X5R, 25 V, 0805, MLCC capacitor</td>
<td>Murata</td>
<td>GRM219R61E106KA12D</td>
<td>FEC 2426961</td>
</tr>
<tr>
<td>C58, C65</td>
<td>2.2 µF, 50 V, 0805, X7R capacitors</td>
<td>TDK</td>
<td>C2012X7R1H225K125AC</td>
<td>FEC 2346945</td>
</tr>
<tr>
<td>C186</td>
<td>SMD capacitor</td>
<td>EPCOS</td>
<td>B37921C9104K60</td>
<td>Digi-Key 495-3265-1-ND</td>
</tr>
<tr>
<td>L1</td>
<td>1000 Ω at 100 MHz, 1206, WE-CBF SMD, EMI suppression ferrite</td>
<td>Wurth</td>
<td>742792141</td>
<td>Wurth 742792141</td>
</tr>
<tr>
<td>L3</td>
<td>10 µH, inductor, shielded power, XAL40 series</td>
<td>Coilcraft</td>
<td>XAL4040-103ME</td>
<td>XAL4040-103ME</td>
</tr>
<tr>
<td>L4</td>
<td>2.2 µH, inductor, shielded power, XAL40 series</td>
<td>Coilcraft</td>
<td>XAL4020-222MEB</td>
<td>Coilcraft XAL4020-222MEB</td>
</tr>
<tr>
<td>LED1</td>
<td>LED, SMD green</td>
<td>OSRAM</td>
<td>LGQ971</td>
<td>Digi-Key 475-1409-1-ND</td>
</tr>
<tr>
<td>R1</td>
<td>2.4 kΩ, 0.063 W, 1%, 0603 resistor</td>
<td>Multicomp</td>
<td>MC0063W060312K4</td>
<td>FEC 9330879</td>
</tr>
<tr>
<td>R2</td>
<td>100 kΩ, 0.1 W, 1%, 0805 resistor</td>
<td>Multicomp</td>
<td>MC01W08051100K</td>
<td>FEC 9332405</td>
</tr>
<tr>
<td>R3, R11, R12, R13, R14, R20, R21, R23, R25, R36, R38, R40, R42, R44, R46, R48, R50, R51, R52, R53, R59, R66, R68, R69, R73, R74, R75, R77, R78, R79, R85, R86, R90, R91, R95, R96, R99, R100</td>
<td>0 Ω, SMD resistors</td>
<td>Multicomp</td>
<td>MC 0.063W 0603 0R</td>
<td>FEC 9331662</td>
</tr>
<tr>
<td>R4, R5, R8, R9</td>
<td>1 kΩ, 0.063 W, 1%, 0603 resistors</td>
<td>Multicomp</td>
<td>MC0063W0603111K</td>
<td>FEC 9330380</td>
</tr>
<tr>
<td>R7</td>
<td>88.7 kΩ, 1%, 0805 resistor</td>
<td>Vishay Draloric</td>
<td>CRCW080588K7FKEA</td>
<td>FEC 2139026</td>
</tr>
<tr>
<td>R10</td>
<td>1%, 0805 resistor</td>
<td>Multicomp</td>
<td>MC01W08050R</td>
<td>FEC 9333681</td>
</tr>
<tr>
<td>R17, R22, R32, R37</td>
<td>49.9 Ω, 0.1 W, 0.1%, 0805 resistors</td>
<td>Panasonic</td>
<td>RN73C2A49R9BTG</td>
<td>FEC 1140694</td>
</tr>
<tr>
<td>R24, R41</td>
<td>200 Ω, 0.1 W, 1%, 0805 resistors</td>
<td>Multicomp</td>
<td>MC01W08051200R</td>
<td>FEC 9332758</td>
</tr>
<tr>
<td>R27, R28, R34, R35</td>
<td>Thick film chip resistors</td>
<td>Vishay Draloric</td>
<td>CRCW0805590RFKEA</td>
<td>FEC 1653021</td>
</tr>
<tr>
<td>R45, R65, R67</td>
<td>10 kΩ, 0.1 W, 1%, 0805 resistors</td>
<td>Multicomp</td>
<td>MC01W0805110K</td>
<td>FEC 9332391</td>
</tr>
<tr>
<td>R93</td>
<td>20 kΩ, 0.1 W, 0.63%, 0805 resistors</td>
<td>Multicomp</td>
<td>MC0063W0603120K</td>
<td>FEC 9330771</td>
</tr>
<tr>
<td>R6, R15, R16, R18, R19, R25, R39, R30, R31, R33, R39, R43, R49, R54, R55, R56, R57, R58, R60, R70, R71, R72, R76, R80, R84, R87, R88, R89, R92, R94, R97, R98, R101</td>
<td>SMD resistors, 0603</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>Do not place</td>
</tr>
</tbody>
</table>

Table 6. Evaluation Board Models

<table>
<thead>
<tr>
<th>Product</th>
<th>Ordering Model</th>
<th>Sample Rate (MSPS)</th>
<th>Resolution (Bits)</th>
<th>Package Used on Evaluation Board</th>
</tr>
</thead>
<tbody>
<tr>
<td>AD4000BRMZ</td>
<td>EVAL-AD4000FMCZ</td>
<td>2</td>
<td>16</td>
<td>10-lead MSOP</td>
</tr>
<tr>
<td>AD4001BRMZ</td>
<td>EVAL-AD4001FMCZ</td>
<td>2</td>
<td>16</td>
<td>10-lead MSOP</td>
</tr>
<tr>
<td>AD4002BRMZ</td>
<td>EVAL-AD4002FMCZ</td>
<td>2</td>
<td>18</td>
<td>10-lead MSOP</td>
</tr>
<tr>
<td>AD4003BRMZ</td>
<td>EVAL-AD4003FMCZ</td>
<td>2</td>
<td>18</td>
<td>10-lead MSOP</td>
</tr>
<tr>
<td>AD4020BRMZ</td>
<td>EVAL-AD4020FMCZ</td>
<td>1.8</td>
<td>20</td>
<td>10-lead MSOP</td>
</tr>
</tbody>
</table>
## RELATED LINKS

<table>
<thead>
<tr>
<th>Resource</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADA4805-1</td>
<td>0.2 μV/°C Offset Drift, 105 MHz Low Power, Low Noise, Rail-to-Rail Amplifier</td>
</tr>
<tr>
<td>ADA4807-1</td>
<td>Low Power, Low Noise and Distortion, Rail-to-Rail Output Amplifier</td>
</tr>
<tr>
<td>ADA4940-1</td>
<td>Ultralow Power, Low Distortion, Fully Differential ADC Driver</td>
</tr>
<tr>
<td>ADR3450</td>
<td>Micropower, High Accuracy 5.0 V Voltage Reference</td>
</tr>
<tr>
<td>ADR4550</td>
<td>Ultralow Noise, High Accuracy 5.0 V Voltage Reference</td>
</tr>
<tr>
<td>ADP7118</td>
<td>20 V, 200 mA, Low Noise, CMOS LDO Linear Regulator</td>
</tr>
<tr>
<td>ADP7182</td>
<td>–28 V, 200 mA, Low Noise, Linear Regulator</td>
</tr>
<tr>
<td>ADM660</td>
<td>CMOS Switched Capacitor Voltage Converter</td>
</tr>
<tr>
<td>ADP2370</td>
<td>High Voltage, 1.2 MHz/600 kHz, 800 mA, Low Quiescent Current Buck Regulator</td>
</tr>
<tr>
<td>ADP5300</td>
<td>50 mA/500 mA, High Efficiency, Ultralow Power Step-Down Regulator</td>
</tr>
<tr>
<td>EVAL-SDP-CH1Z</td>
<td>High-Speed Controller Board for System Demonstration Platform (SDP-H1)</td>
</tr>
<tr>
<td>AN-931</td>
<td>Understanding PulSAR® ADC Support Circuitry</td>
</tr>
</tbody>
</table>

### Legal Terms and Conditions

By using the evaluation board discussed herein (together with any tools, components documentation or support materials, the “Evaluation Board”), you are agreeing to be bound by the terms and conditions set forth below ("Agreement") unless you have purchased the Evaluation Board, in which case the Analog Devices Standard Terms and Conditions of Sale shall govern. Do not use the Evaluation Board until you have read and agreed to the Agreement. Your use of the Evaluation Board shall signify your acceptance of the Agreement. This Agreement is made by and between you (“Customer”) and Analog Devices, Inc. (“ADI”), with its principal place of business at One Technology Way, Norwood, MA 02062, USA. Subject to the terms and conditions of the Agreement, ADI hereby grants to Customer a free, limited, personal, temporary, non-exclusive, non-sublicensable, non-transferable license to use the Evaluation Board FOR EVALUATION PURPOSES ONLY. Customer understands and agrees that the Evaluation Board is provided for the sole and exclusive purpose referenced above, and agrees not to use the Evaluation Board for any other purpose. Furthermore, the license granted is expressly made subject to the following additional limitations: Customer shall not (i) rent, lease, display, sell, transfer, assign, sublicense, or distribute the Evaluation Board; and (ii) permit any Third Party to access the Evaluation Board. As used herein, the term “Third Party” includes any entity other than ADI, Customer, their employees, affiliates and in-house consultants. The Evaluation Board is NOT sold to Customer; all rights not expressly granted herein, including ownership of the Evaluation Board, are reserved by ADI. CONFIDENTIALITY. This Agreement and the Evaluation Board shall all be considered the confidential and proprietary information of ADI. Customer may not disclose or transfer any portion of the Evaluation Board to any other party for any reason. Upon discontinuation of use of the Evaluation Board or termination of this Agreement, Customer agrees to promptly return the Evaluation Board to ADI. ADDITIONAL RESTRICTIONS. Customer may not disassemble, decompile or reverse engineer chips on the Evaluation Board. Customer shall immediately inform ADI of any occurred damages or any modifications or alterations it makes to the Evaluation Board, including but not limited to soldering or any other activity that affects the material content of the Evaluation Board. Modifications to the Evaluation Board must comply with applicable law, including but not limited to the RoHS Directive. TERMINATION. ADI may terminate this Agreement at any time upon giving written notice to Customer. Customer may not return the Evaluation Board to ADI. The Evaluation Board must comply with applicable law, including but not limited to the RoHS Directive. TERMINATION. ADI may terminate this Agreement at any time upon giving written notice to Customer. Customer agrees to return to ADI the Evaluation Board at that time. LIMITATION OF LIABILITY. THE EVALUATION BOARD PROVIDED HEREUNDER IS PROVIDED "AS IS" AND ADI MAKES NO WARRANTIES OR REPRESENTATIONS OF ANY KIND WITH RESPECT TO IT. ADI SPECIFICALLY DISCLAIMS ANY REPRESENTATIONS, ENDORSEMENTS, WARRANTIES, OR WARRANTIES, EXPRESS OR IMPLIED, RELATED TO THE EVALUATION BOARD INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF MERCHANTABILITY, TITLE, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF INTELLECTUAL PROPERTY RIGHTS, IN NO EVENT WILL ADI AND ITS LICENSORS BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES RESULTING FROM CUSTOMER’S POSSESSION OR USE OF THE EVALUATION BOARD, INCLUDING BUT NOT LIMITED TO LOST PROFITS, DELAY COSTS, LABOR COSTS OR LOSS OF GOODWILL. ADI’S TOTAL LIABILITY FROM ANY AND ALL CAUSES SHALL BE LIMITED TO THE AMOUNT OF ONE HUNDRED US DOLLARS ($100.00). EXPORT. Customer agrees that it will not directly or indirectly export the Evaluation Board to another country, and that it will comply with all applicable United States federal laws and regulations relating to exports. GOVERNING LAW. This Agreement shall be governed by and construed in accordance with the substantive laws of the Commonwealth of Massachusetts (excluding conflict of law rules). Any legal action regarding this Agreement will be heard in the state or federal courts having jurisdiction in Suffolk County, Massachusetts, and Customer hereby submits to the personal jurisdiction and venue of such courts. The United Nations Convention on Contracts for the International Sale of Goods shall not apply to this Agreement and is expressly disclaimed.